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Introduction 
 
Congratulations! You have just acquired the portable creasing and folding analyzer CREASY.  
This device is the optimum tool to control the converting process of creasing. It measures the 
characteristics of the bead, the spine, the folding symmetry and angle in a fast and intuitive 
manner.  The software automatically creates quality control reports. 
 
The CREASY software is available in two versions: 
 

• Basic Version 

• PREMIUM Version 
 
The Help Menu offers functions to activate Software Modules by inserting License codes. 
 
This manual will always outline functions that are available only in the premium version. The 
software can be upgraded from Basic to Premium by an upgrade code.  
 

PREMIUM version 

Contact your dealer to get the proper upgrade code for your device. Insert the upgrade codes by 
selecting the PREMIUM upgrade function from the Help menu. 
 

 
 
In addition there are available optional function modules. These modules require the PREMIUM 
license. 
 

CREASING RULE  

 The Creasing Rule function enables you to measure the characteristics of your creasing rules. 
The function can be accessed only if the CREASING RULE option is enabled. Insert the 
CREASING RULE code by selecting the Creasing Rule License Item from the Help menu. 
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POWER CREASE 

The Power Crease function offers additional job statistics for crease and embossing 
measurements. Additional crease profile calculations are also available with this function module. 
The function can be accessed only if the POWER CREASE option is enabled. Insert the POWER 
CREASE code by selecting the Power Crease License Item from the Help Menu.  
 

 
 
The POWER CREASE option consists of an upgrade code and a hardware tool that helps to keep 
the sample flat during crease or embossing measurement. 
 

 

E-GUIDE 

The E-GUIDE option is composed of a mechanical tool that guides you while pulling the CREASY 
over the embossed area. This leads to a repeatable, fast and accurate control of your embossed 
area. The function can be accessed only if the E-GUIDE option is enabled. Insert the E-GUIDE 
code by selecting the E-GUIDE License Item from the Help Menu. 
 

 
 
E-GUIDE is supplied with the mechanical E-GUIDE Tool 
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EGUIDE-PRO and EGUIDE-PRO2 

The EGUIDE-PRO Option is a motorized version of the EGUIDE Option offering additional 
software functions. The EGUIDE-PRO Software enables you to save and load scanning images. It 
also highlights the deep area and the area that is as deep or deeper than the reference. In case 
the PowerCrease Licence is activated there can be inserted references and customized box 
layouts for embossing. In addition, special test patches for embossing are available in this case. 
 
Insert the EGUIDE-PRO License code by selecting the EGUIDE-PRO Item from the Help Menu. 
 

 
 
The EGUIDE-PRO is supplied with the mechanical EGUIDE-PRO2 Tool.  
 

 
 

3D View 

The 3D View function offers a tool to display the embossed area that has been scanned using the 
EGUIDE-PRO, in 3D. Insert the EMBOSS 3D License code by selecting the 3D View Item from 
the Help Menu. 
 

 
 

POWER BOX 

 
The POWER BOX function offers additional job statistics for finished boxes. Insert the POWER 
BOX code by selecting the Power Crease License Item from the Help Menu.  
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The POWER BOX Option is supplied with a mechanical tool to position and hold the finished box 
in an convenient and repeatable manner. 
 

 
 

Laser Crease 

Crease lines can be created by ablating the top paper layer using a Laser. These crease lines can 
be measured using the Laser Crease Software Module. Activate the Laser Crease function by 
inserting the Laser Crease License code. 
 

 
 

Cutting 

The Module Cutting offers functions to evaluate the quality of a cutting edge. Fibers on the edge 
will lead to paper dust during printing and reduce print quality. In addition there can be evaluated 
the cross section of a crease line. 
 
Insert the license code to activate the function. 
 

 
 
The Module is composed of a license code and a holder to easy the positioning of the paper edge. 
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Tactile warning triangle 

The module tactile warning triangle is a special measurement mode to measure the tactile warning 
triangle using the Creasy with the EGUIDE-PRO2. The tactile warning triangle is a equilateral 
triangle with a size of approx.. 18mm x 18mm x 18mm.  
 
Insert the license code to activate the function. 
 

 
 
Important: This manual describes the current version of the CREASY hardware and software.  
Future enhancements or modifications are reserved. 
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Safety Instructions 

Warning 

For safety reasons it is absolutely necessary to read through the user’s guide and all of the 
instructions it contains. 

General safety rules 

If the safety recommendations and instructions in this User Guide are not complied with, 
measurement errors or data loss or physical injury or property damage may result 
 

• CREASY is not intrinsically safe. Therefore, the device cannot be used in an environment 
with explosive vapors where there is a risk of spark ignition. 

• CREASY may not be used in an area with strong electromagnetic fields. 

• Use the CREASY in ambient temperatures between 10°C (50° F) and 40°C (104°F), and do 
not expose the CREASY to direct sun light. 

• The CREASY Sensor should never be opened as there are no user-serviceable parts.  
Doing so voids the guarantee.  Contact your authorized dealer if repairs are necessary. 

• To avoid incorrect handling, the CREASY should only be used by trained personnel 

• The CREASY should only be used on dry measurement objects. 

• The CREASY should be protected against chemicals, corrosive vapors, strong mechanical 
vibrations and impacts. 

• Use original spare parts and accessories only. 

• Use the original packaging exclusively when transporting. 

• The CREASY casing can be cleaned with a dry cloth. 
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Installation 
Start your Computer and wait until all boot processes have terminated and your computer is ready 
to operate.  Do not plug the USB cable in at this time. 
 
Plug the CREASY USB Memory Stick into a free USB Port and wait until Windows has recognized 
and registered the USB Stick as a Mass storage Device. 
 

Install the CREASY software 

 
The USB Memory stick contains a setup utility ‘setup CREASY.exe’, which can be run to install 
the CREASY Software on your PC.   
 
Before termination the video driver installer will automatically be started. Click INSTALL. 
 

  
 
Wait until the installation of the driver is finished. 
 
Now connect the USB cable to a free USB2.0 port.  Windows will automatically detect the driver 
and assign it to the device. 

Run the application 

• Launch the CREASY.exe or 

• Click the CREASY Icon on your desktop or,  

• Run the CREASY from the Windows Start Menu 
 
You can use one Software installation for multiple Hardware devices. Copy the 
‘<serialnumber>_CREASY.INI’ file from the USB Stick into the Installation directory of your 
computer. If more then one of those files is located at program start, than the software will 
promptfor Device selection: 



 

CREASY Manual GB.docx  10 / 93  1/25/2024 
 

 

 
 

 Select a device from the list and click the preview Icon.  
 

 Click the Cancel Icon to maintain the most recently used device. 
 
You can always change the connected device by selecting the ‘Select Device’ item from the 
‘Device’ Menu. 

 

Main Window 
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A) Captured image for analysis 
B) Box definition window 
C) Live camera image 
D) Analysis modes and graphical results 
E) Numerical Results and Report preview 

Main Window Icons 

Main Menu Functions 

 

 Measure a new box in production quality control mode 

 Measure new embossing-debossing job (Power Crease only) 

 Measure embossing using the embossing patch (Power Crease only) 

 Measure a new finished box job (Power Box only) 

 Save the current image 

 Load Image 

 Open Standards Database 

 Open Statistics on quality reports 

 Analyze image 

 Display the EGUIDE-PRO Image in 3D (3D View only) 

Camera Functions 

 

 Preview 

 Capture 
 

Setup Statistics and Job Statistics Functions 

 

 Clear statistics 

  Automatically add most recent measurement and all subsequent measurements to 
statistics and re-calculate Average, Maximum and Minimum and Standard Deviation. Click this 
icon again to stop adding measurements to statistics. 
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 Remove most recent measurement from Statistics 

 Save actual statistical data 

 Copy Data to Windows Clipboard (press shift to copy with titles) 

 Accept and save data – create PDF report 

 Cancel box data collection 
 

Reference Database Functions 

 

 Add new Box reference 

 Remove Box reference from Database 

 Copy a reference 

 Calculate tool dimensions 

 Select Box Layout (PREMIUM Version only) 

 Measure references 

 Open Box Editor (PREMIUM Version only) 

 Get a proposal for the brightness settings 

 Clear the database by removing all references permanently. 

 Import References from another database. 
 

 Save Database and close Window 

 Undo changes and close Window 
 

Copy Functions 

Use the key combination STRG+C to copy the bottom Area of the Main Window (C+D+E) to the 
Windows Clipboard. Use the PASTE function of your Windows application to paste the image. 
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Configure your installation 
Select Settings from the file menu. Select your language from the Language page. 
 

Select your language 

 

 
 

 You can protect additional settings by password. Check or un-check the 
Password protection item on the right bottom. Insert the password <creasing> to make your choice 
permanent.  
 

 
 
The password protection will disable the modifications of all settings. Only the language can still 
be selected. Further modifications of references are disabled by this function. 
 

Configure data representations and functions in use 

 
Select the Additional page to access additional system settings  

• Change between metric system (mm) and Imperial (inch) system 

• Select the number of significant digits for measurement results 

• Select the number of beads in case of multi bead measurements. If 1 is selected, then the 
software will automatically detect the number of beads. 

• Select History if the previous measurement should be displayed by a red line or the 
previous measurement is not displayed at all. 
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• Select the mathematical formula for the opening calculation of the crease measurement. 
Narrow opening is an alternative interpretation for the starting and ending of a creasing line 
cross section on the material surface. By default, Narrow Opening is checked. Unchecked 
Narrow opening should be used only for materials that are showing sharp edges at the top 
end of the crease. 

• Select if a noise filter should be applied to the surface profile curve and how strong this filter 
should be (values 0 = no filter, 10 = very strong filter). The noise filter will reduce the impact 
of surface structure like fibers, print or gloss. Please note, that a noise filter always makes 
the curves smooth and therefore eliminates drawing details. Small differences may appear 
in measurement values depending on the filter setting. It is recommended to use filter 
setting 0 if very tiny structures should be measured (like cut score lines). On rough 
surfaces, glossy surfaces or printed surfaces the noise filter can help to improve the 
repeatability of the readings. 

• Enable and disable measurement functions. The available measurement function set can 
differ depending on the Licenses activated in your software.  
 

• When the Power Crease Module is activated there is a separate filter setting for crease 
measurements. In addition, the level for the crease width measurement can be selected. 
Insert a value followed by % to specify a percentage level. Insert a value without % to 
specify the level in microns. The level is always calculated starting from the bottom of the 
crease. 
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Configure the layout of Reports 

 
Select the Reports page 
 
Load your company Logo that will be applied to your quality reports by clicking the File Open Icon. 
Insert your company details below as they will appear in the header of any report. Specify the 
output format for tab delimited text format output. 
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Important: in order to save and re-load setup process data the ‘Output Header’ flag needs 
to be checked. 
 
Select if the Average Embossing Value should be calculated. Select if the percentage of 
embossed are deeper than a reference should be displayed. 
 
The 3DView Option offers the possibility to output the 3D image of the actual measurement on the 
PDF reports. In this case the third option needs to be checked: 
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Select the path for database files and communication parameters 

 
The PREMIUM version offers in addition the software configuration page.  
 

 
 

Select the file location of the reference database. Select the database file by clicking the 
open Icon on the right side. 
 
Import Data from v3.x Databases into v4.3 database. 
 
 
Repair a corrupted database. 
 
Select if the database can be modified or not. Use this flag to prevent the user from 

editing the database in case of multi-user installations accessing the same reference database file. 
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When the Power Crease Module is active, the database file for the embossing-debossing 
references can be selected. 
 
When the Power Box Module is active, the database file for the finished Box references can be 
selected. 
 
In addition, you can select the destination path where all PDF reports should be saved. The 
reports will be saved into sub-directory of the selected path. When the Power Crease Module is 
activated, you can save original captured images into a sub directory \SetupRep\Img by selecting 
the Save Image Selector. 
 
Select if the PDF report should be displayed after creation. 
 
Select if during job measurement the next crease type is selected automatically after the number 
of predefined measurement positions have been measured for the current crease type. 
 
The CREASY PREMIUM can run on a network communicating with a server application based on 
two communication protocols: TCP-IP e HOT FOLDER. For details check the manual CREASY 
Host Interface.pdf. 
 

Configure the parameters of the EGUIDE-PRO device 

 
In case the E-GUIDE Module is activated there are available settings on the EGUIDE Page 
 

•  

• Before starting to scan there will appear a traffic light giving you the time 
to be prepared for scanning. This delay can be configured as Start Delay. 

 

• Select the %  of deepest or highest area that should be used to 
calculate the embossing depth. 10% is a reasonable value. This number can be understood 
as the height of the red window in below drawing.   

•  
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•  In order to optimize the image capture process, it is 
necessary to specify, if you are going to measure hills or valley and what the expected 
height or depth will be. Select if you are going to measure hills or valleys. The expected 
depth should be approx. 20%-50% higher than your target depth. If your target depth for 
example is 50 microns, insert 60 or 70 here. 
 

• EGUIDE PRO is supplied with a plastic film to be placed on 
top of the box blank. This will prevent the CREASY to stick during motion. Insert the 
thickness of the plastic film here. Default is 180 microns. If you do not use a plastic film, un-
check the function. 
 

• if the embossing type without border warp recognition is 
selected, a full size warp compensation is applied. The strength of this compensation can 
be configured 0 = no compensation and 10 = max compensation. 

 

•  The result image can highlight the embossed area in color. Select the red 
A in case you would like to highlight the embossed area. 
 

Select the type of embossing 

The CREASY Software can be configured to measure different types of embossing. Some are 
generic, where the algorithm does not have any knowledge about the layout and the measurement 
area can also pick only a sub-set of the entire embossing area. Some are more specific defined by 
a embossing patch. 
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•  Generic embossing :The embossing depth calculation 
needs card board surface as a reference.  

o If your embossed area fits into the viewing area of 9mm height and up to 
70mm width, select the left icon. This measurement is slightly more precise as there 
is substrate reference available around the embossing area.  

o In some cases, the embossed are does not fit into the 9mm viewing area. If 
the subject can be aligned such as on bottom there is still surface available, at the 
beginning, at the end of the scan and on bottom there will be cardboard surface 
available. Use the Left/Right/Bottom selection in this case.  

o In some cases, the embossed are does not fit into the 9mm viewing area. In 
this case only at the beginning and at the end of the scan there will be cardboard 
surface available. Use the Left/Right selection in this case.  

o Little embossed surface structures all over the area can be measured with 
the option at the right hand. In this case there will not be calculated nor applied a 
surface correction at all. 

 
 

• Embossing patch (Power Crease required): Using embossing 
patches will make the process control significantly easier and less dependent on operators. 
The predefined patches perfectly fit into the measurement area of the device. The 
positioning is easy and the measurements are highly repeatable. 
 

o Embossing with two depths. This patch can be measured as 
embossing or de-bossing with two depths or two heights 

 

  
 
Design the tooling according to below dimensions in mm. Select the depths/heights 
representative to the embossing in your layout: 



 

CREASY Manual GB.docx  21 / 93  1/25/2024 
 

 

 
   8mm x 15mm patch  9mm x 9mm patch 

 

o Embossing De-bossing patch. This patch is used if inside an embossing area 
there will be also de-bossing. 

 
 

Design the tooling according to below dimensions in mm. Select the depth and 
height representative to the embossing in your layout: 
 

 
9mm x 15mm embossing-de-bossing patch 

Tactile warning triangle  

 
The tactile warning triangle is larger than the aperture of the creasy scanning area. The triangle is 
positioned such as the base line and a section of the left and right triangle shoulders are inside the 
aperture. 
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Test and calibrate the EGUIDE-PRO motion parameters 

 

• In case the EGUIDE-PRO module is activated there are additional functions on the 
EGUIDE Page.  

 

 
 

o Select the com port and click the connect button 
o Click the Get ID button to check if the software connects to the device. The device 

will answer with E-GUIDE and Firmware version 

o Use the left/Stop/right buttons to move the device  

o Click the HOME Icon to move the CREASY to the home position  
o Click the MOVETO Icon to move the CREASY to a specified position with a specified 

speed. 

 
 

The next to the connect button will give our support access to your hardware. Do not change 
any parameters here by yourself. The access is password protected. 
 
Below actions are necessary only if you use a EGUIDE-PRO Hardware. The EGUIDE-PRO is 
estimating the distance to move by estimating the time needed to get to a position. The 
Timing of your Windows System can have an impact such as the real distance moved can 
show differences over time. 
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The EGUIDE-PRO2 Hardware is equipped with encoder and will automatically move to a 
requested position with a constant predefined speed. Distance and speed are independent 
from the timing of the Windows Operating system. 
 
On bottom there are available Special settings that can accessed by clicking the … below the 
GETID button. 
 

 
 
The Software does support a maximum of 500 cross section images per scan. For old/slow 
computers there might be a limitation in terms of memory or processing speed such as the 
maximum of Scan Images needs to be set to a lower number (f.e. 200). 
 
The software will calculate the current number of images and the current motion speed based on 
the maximum images, the scanning distance and the minimum motion speed.  
 
The EGUIDE-PRO will move over the scanning area until all images are captured. Therefore, slow 
computers will move a longer distance than fast computers. If. for example, there is any other 
application running in the background the scanning distance will differ from scan to scan 
depending on the actual work load. This will have only a minor impact on the measurement result. 
The EGUIDE-PRO can be matched to your PC by adjusting the Speed factor. Perform the 
following steps. 
 

 
 

• Fix the left end position and move the carriage in its left home positon. 

• Unscrew the right end position nob such as it can move freely and move it to the right end 
of the carriage 

• Now set the distance to 50 in the main screen and start the scanning. 

• The carriage now will move approx. 50mm capturing 500 images (or less depending on 
your settings). While moving it will move also the right end nob to the right. At the end of 
scanning the carriage will be moved to the left home position again. 

• Measure the distance between the right nob and the right end of the carriage with a ruler 

• Insert the measured distance into the Real Distance field 

• Click the CALC button 

• The Speed factor will be calculated and saved. 
 
Version 3.0.0 does support a more accurate speed calibration system for the EGUIDE-PRO. If the 
new Calibration is executed once, old type calibrations are not used any more. 
 

• Move the carriage to the left starting position. 

• Fix the right blocking knob at a distance of exact 50mm from the right extend of the carriage 
such as the moving distance is limited to exact 50mm. 
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•  

•  Now click the calibration Icon to start the calibration process. 

• The calibration will take 10-15 minutes. Do not interrupt the calibration process. The 
progress bar will display the progress of the calibration. 

• The calibration can be repeated at any point in time. In any case it should be repeated on a 
weekly basis for accurate positioning results. 
 

Even after calibrating the Speed Factor there might be a variation of +- 2-3 mm in distance 
depending on processes running in the background. 
 
If the Speed Factor is checked, the simple, linear speed calibration is applied. 
 

XML Interface 

Reference definitions can be exchanged between installations using XML files. The references 
can be saved by clicking the export icon on the reference page. 
 

 
 
The currently selected reference will be saved to the XML Output folder. 
 
The reference can be loaded to the reference database using the XML input button. 
 

 
 
The file open window will automatically open the XML input folder. Select the file to load the 
specification. If a reference with the name stored in the XML file already exists, the reference 
specification will be replaced by the XML reference. If the no reference with the name of the XML 
reference does exist in the database, the XML reference will be added to the database. 
 
The XML input folder and the XML output folder are selected in the settings Window. The most 
recently used XML file is printed in the memo field. 
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Superuser, Administrator, Operator 

The Creasy Software does support the configuration of access permissions for three levels: 

• Superuser only 
o Add users, remove users, change permission of users, reset user password 
o Open a new database 
o Create a new database 
o Activate or deactivate licenses 

• Administrator or Superuser 
o Check activities by user 
o Device verification 
o Boxeditor 
o Add, delete, modify references 
o XML input-output 

• Operator, Administrator, Superuser 
o All other functions.  

 
Add a new user 
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Click the + icon to add a new record. Write the name of the user into the Name field of the table. If 
automatic digital signature should be added to reports, enter the PFXFile name and path for the 
signature. Click the check icon to confirm. 
 
If there has not yet defined a superuser, the first user will automatically be assigned superuser 
permission. 
 
As a general rule the expire time for the password can be configured on this page. In addition 
existing passwords can be reset. 
 

Software access by user login 
Once there have been created users, the software will prompt for the user login. At the very first 
time the user will need to input a new password that complies to the rules described in the login 
window. After the password has expired, the user will again be prompt to insert a new password. 
 

 
 
At any point in time, another user can login clicking the Login Item from the main user menu. 
 

 
 
The user is now displayed in the data area of the creasy software. 

 
 
The login user can not be replaced by a random name and is pre-selected in the job measurement 
modes. 
 
Activities performed by a user are collected in a database. Select the Action list Item from the user 
menu to open the database.  
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 export data to a text file or an excel sheet 

 create an archive database with the current records of the table and empty the table. 

 reopen an archive. 
 

Standards Database 
The CREASY software offers a database with standards. The database is in Absolute Database 
format and stored in one single file with file extension .abs. This makes the transfer of references 
from on installation to another installation easy and save. 
 
The CREASY software can handle as many databases as required. 

Create a new database 

Select the ‘File/New Database’ Item from the main Menu. Enter a new File name and click OK. 
The Database will be created and open automatically.  
 

Open a database 

Select the ‘File/Open Database’ Item from the main Menu. Select an existing database file and 
click OK. The database will open and all references will be available. 
 

Folded Box Blank reference 

Click the database icon to open the database interface.  
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Depending on the set of enabled software modules there might appear or not appear features of 
above image. 
 
The Folded Box Blank Page is used to specifiy the creasing process parameters of a box blank. 
The basic version of the CREASY offers up to 4 different specifications to be used, one in parallel 
to fibers, one across fibers, and two diagonal ones. 
 

Bead, Round Corner, Beveled Edge, Laser Crease 

The Box blank can have up to 7 different specifications A..G if the PREMIUM version is used. It is 
recommended to measure the bead side of the box blank (the inner side) as the bead does tell 
you significantly more about process variations than the crease side. The bead type now can be 
standard – i.e. the inner side of a single crease line. It can be a round corner application – i.e. a 
combination of up to seven positive and negative crease lines parallel to each other and very close 
to each other. There can also be specified a double bead that will build a beveled edge after 
folding (PowerCrease Option). Finally it can be a laser engraved crease line or up to 7 parallel 
lasere engrave crease lines (LaserCrease Option). There can also be specified up to 7 crease 
lines (PowerCrease Option) and up to 7 Scoring Lines (PowerBox Option). 
 
You can maintain your own database by adding or removing records from the database. 
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 Click the ADD Icon to add a new record. Compile the fields and click OK.  
 

 Select the record from the list that you would like to remove from the database. Click the 
delete icon to remove the record from the list. 
 

 Create a new reference record and copy the data of the selected record into the new record  
 
Select the record from the list you would like to modify. Modify the data and click OK. 
The Bead and Spine dimensions as well as the requirements for the crease channel dimensions 
differ depending on the direction of the crease and fibers of the material. The standard database 
offers four different references (A), (B), (C), and (D) . In case of PREMIUM version there can be 
used up to 7 different references whereby the naming of the references can be selected with the 
box editor (see below).  
 
The crease of type B are assumed to be perpendicular to the crease of type A. 
 
 
The orienation of the package can be defined as “A” being parallel to fibers or “A” being orthogonal 
to fibers. 
 

• Create a new reference by clicking the  Icon. 

• Insert a new name into the Standard field. 

• Select the orientation of the A-crease 

• Based on material thickness, tool width and fiber orientation you can calculate a proposal 
for the crease channel specifications for A and B  by clicking the calculator Icon. If you 
would like to use other specifications, type the new values into the proper edit fields. 

 
 

 
 
Select the camera settings to be used to measure this material: 
 

 
 

 Position the Device on a typical bead of the target material. Click this icon. The Software will 
automatically test different settings and select the best setting for the current material. The 
selection will be confirmed by a beep.  
 
There are four sets (A), (B), (C), and (D), of references for each record: one for crease parallel to 
fibers and one for crease perpendicular to fibers and two diagonoal crease types. 
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The PREMIUM version of the CREASY Software offers seven sets of references per box that can 
be configured by means of the box editor  
 
In addition the PREMIUM version implements the possibility to link a specific customized Box 
Layout to any reference. The Basic version offers only one standard Box Layout. 
 

 Click the Box Layout selection Icon to open the list of available Box Layouts. 
 

 
 
Select a Box Layout by clicking into the graphical display of the proper Box Layout. Link the 
selected Box Layout permanently to the actual selected refence by clicking the OK icon. 
 

  When a Box layout has not yet been defined a, you can open the box editor by clicking the 
Box editor Icon. Define a Box Layout and link it to the actual reference set as described above. 
  
 
Insert reference numbers and tolerances. 
 
 
Specify the noise filter for this reference. The noise filter always removes tiny details of the 
measured profile that might cause small differences in measurement results between filter and no 
filter. It is recommended to use a filter on rough surfaces, glossy surfaces or surfaces with print.   
Use no filter (value = 0) in case sharp corners or very small objects such as cut scores need to be 
measured. 
 

 Reference values can also be defined by measuring samples. Click the Measure sample 
icon of the proper column to start the measurement process. Measure the bead of the samples. To 
finish, click OK to permanently save the new reference values. 
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Crease 

When the Power Crease Module is activated references for crease measurements can also be 
inserted. 
 

´ 
 
In case of crease measurement insert the level of width measurement. 
 

Scoring 

If the PowerBox Module is activated there can be inserted references for Scoring Depth 
measurements. 
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Specify individual tolerances for every single crease type. 

For bead, crease and scoring there can be specified an individual tolerance. If you do not use 
individual tolerances, the tolerance specified for type [A] will automatically be applied to any other 
type [B,C,D,E,F,G]. Individual tolerances are supported by a database v4.6 or newer. If your 
database version is older, you need to migrate to the new version. Create a new database in this 
case and import all records from your current database into the new database. 
 
Input individual tolerances by clicking the ‘…’ next to the crease type names. 
 

 
 
Input the tolerances and click the check icon. 
 

 
 

Embossing and De-bossing reference 

 



 

CREASY Manual GB.docx  33 / 93  1/25/2024 
 

 

The Power Crease Module also supports the use of references for embossing and debossing. 
Select the embossing/debossing page to insert references and tolerances. 
 

 
 
 
The EGUIDE and EGUIDE PRO options require more specifications to use the proper settings 
during measurement. They will automatically be recalled during a Job measurement process. 
 
If you own an EGUIDE-PRO2 Hardware, you can specify the start point for the scanning as an 
offset from the home position. In case only one single location is defined for a reference type 
[A]..[F] and the Auto select next crease option in the settings is active, the subsequent embossing 
feautes will be scanned automatically during the JOB measurement function whithout the need to 
restart the scanning for every single feature. 
 

Specify the scanning distance for the embossed are. 
 

 Check this box for an embossing refernce if you are going to measure 
embossing (hills, being higher than the standard surface). Leave it unchecked in case you 
measure debossing (valleys). 
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Tell the system where to take the surface reference of your measurement sample or if the 
measurement target is an embossing patch. 
 
In case of embossing patch the first reference (A) per position is always linked to the deeper 
portion of the test patch. 
 

 specify if you are going to use this reference definition along with 
an EGUIDE-PRO, with a manual EGUIDE or without any scanning support. 
 

Folded box reference 

 
The Power Box Module enables the Reference database for glued and folded boxes. 
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Click OK to save the current modifications. 
 

 
 
Click the SAVE Icon to close the window and to permanently save all modifications: 
 

 
 

Cutting Edge Refernce 

If Cutting Edge is activated you can insert references and tolerances for the 4 edges of a sheet. 
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4 Quality levels in terms of tolerance can be inserted. 
 
Click OK to save the current record. 
 

 
 
Click save to save the database and close the window. 
 

 
 
 

Import References from a global Reference Database (PowerCrease only) 

If the PowerCrease Option is activated, there are two additional Icons available in the left bottom 
corner of the Reference Database Window. 
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Click the CLEAR Icon to permanently delete all references of the actual Page (box blank, 
embossing, finished box).  
 

 
 
Click this Icon to import Reference definitions from a global Reference database. The software will 
prompt for the file name of the global database. The database needs to be v3.0.0 or newer. If your 
global database is of older format, you can choose to convert it to the new format.  
 
The references of the global database will be displayed in two lists. The list on the left side will 
hold all references that are not yet available in your local database – such as you can import the 
references if required. 
 
The list at the right side will display all references of the global database, that are already available 
in your local database. 
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Select the references you would like to import from the global database to your local database.  

 Click the IMPORT Icon to import reference, click cancel to close without importing data. 
 
 

The Box Layout Editor (PREMIUM Version only) 
Open the Box Layout Editor by selecting the Box Editor from the Tools menu. 
 

 Open an existing Box Layout or import a Box Layout from any JPG, BMP or PNG File. Use 
this icon also to import data from a CFF2 file. Importing form CFF2 will deliver absolute 
coordinates and distances such as the software can support you in placing the measurement 
positions well centered to the crease line. 
 

 As an alternative, you can retrieve the source image by selecting it in the PDF file, copy it to 
the Windows clipboard and clicking the paste icon of the Box editor. 
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 In case the source image does not show high contrast edges, the paste can be performed 
applying a filter. Select the proper area in the source PDF file, copy the image, and click the 
filtered paste Icon. 
 

 You can also load one of the predefined box layouts from the library by clicking the LIB Icon.  
 

 Reload previously defined box blank layouts by clicking the box blank Icon. 
 
 

 
 

 Click the Clear Icon to clear the layout of any measurement locations previously defined. 
 

 Select the type of measurement you would like to define 
measurement locations for. 
 
A preview rectangle will be displayed when moving the mouse arrow over the box layout. 
 

 
 
Move the preview rectangle over the intended measurement position and click the left mouse 
button to store the new position. 
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The new position is of type [A] and the (1) first measurement to be taken. 
 
Insert the next measurement position. 
 

 
 
The new position is of type [A] and the (2) second measurement to be taken. 
 
Continue to click on positions until all [A] measurement locations are set. Now select the [B] icon 
and proceed to define [B] measurement locations. Proceed with [C] and [D] accordingly. 
 

 
 
Folded box blancs can have different types of crease lines like simple crease lines, round corner, 
beveled edges or laser engraved crease lines. Because the measurement algorithms are different 
and there has to be defined the type of the crease line to be measured at the proper position. The 
type can be selected from the drop down list below the type name: 
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The Positions will be displayed in color depending on the selected type 
 

 Select ‘Crease’ for standard crease lines (bead) 

 Select ‘Beveled’ for Beveled Edge (twin bead) 

 Select ‘Auto RC’ to automatically detect the number of creases for Round Corner  

 ‘RC3’..’RC7’ Select the number of creases in case of multi crease for Round Corner 

 Select ‘LC’ for laser engraved crease lines. 
 
 

 Remove a single measurement position by selecting the Remove Icon and clicking with the 
left mouse button into the proper position. 
 
 

 Rename a position by double inserting a text and confirming clicking the 
confirm icon. 
 
All positions that have already been inserted will be renamed automatically by the first character of 
the entered position type name. 
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 Save the Current Box definition 
 

Define measurement locations for embossing (Power Crease only) 

The reference locations for embossing measurements are inserted the same way as you did for 
crease and bead measurement locations. Select a box blank layout and insert A..G locations as 
needed. 
 
In order to add also the scanning direction, press the left mouse button and keep it depressed 
while dragging the mouse across the requested direction. If the CTRL key is depressed only 
vertical and horizontal directions are accepted. 
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 Save the layout as Embossing Reference 

 Open an existing Embossing Reference. 
 

Define Measurement positions for the finished box (Power Box only) 

The reference locations for finished box measurements are inserted the same way as you did for 
crease and bead measurement locations. Select a box layout and insert A..G locations as needed. 
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 Open an existing folded box layout 

 Save the layout as folded box layout 
 

Typical procedure to define new standard 
 

•  Open the standards library window 

• Create a new empty standard 

• Insert the standard Identifier 

•  Insert material thickness and knife width and calculate the tool dimensions. 

•  Create a new Box Layout if required by using the Box Editor. 

•  Link the new Box Layout to the standard by selecting it from the list. 

•  Get a proposal for the brightness settings. 

•  Measure reference boxes that perform properly on the packaging line for any single 
crease type. 

• Insert tolerances 

•  Save the standard permanently into the database. 
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Initialize the camera 

 Click Preview to start the Live Image of the camera 
 

 A flashing left dot shows that the camera is active. A steady right dot shows that the key at 
the device has been pressed, a new image has been captured, and the software is analyzing the 
image. 
 
Select the substrate brightness type (white, gray, black) of the substrate. Use the scroll bare to 
fine tune the brightness. White (or light gray) card board can be analyzed with the standard setting 
shown below. 
 

 
 

Measurement functions: 

 Measure bead characteristics 

Measure crease characteristics 

 Measure twin bead (Beveled Edge) 

Multi Crease measurement (Round Corner) 

 Laser Crease measurement 

 Measure Scoring Depth 

 Measure subsequently bead and crease characteristics and overlay images to obtain 
cross section image 
 

Measure embossing or de-bossing areas 

Measure fine structured embossing or de-bossing areas as for example text. 

 Measure embossing using E-GUIDE 

 Measure embossing using EGUIDE-PRO 
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 Measure the folding characteristics of the finished box. 
 

 Measure the cutting edge 

 Measure the cross section of a crease line 
 
 
If there are more than 8 functions enabled you can scroll additional functions into the window by 
clicking the arrow icons. 
 

 
 

Execute a measurement 
• Click Preview if no Live Image is displayed inside the preview window 

• Select the measurement function 

• Position the device parallel to the crease (or bead) to be measured.  The crease image 
must be centered in relation to the blue guide line overlaid on the PREVIEW image. 

• Press and release the button of the device and hold the device in position until the captured 
image appears in the Analysis Window. 

 
The software automatically calculates the dimensions and displays the results graphically inside 
the result window and the numbers in the table window 
 

Setup Process 
Setup your embosser by measuring various locations of beads and collecting the data in the 
statistics area. Based on this data you can determine the best settings for your process by 
comparing data of well-performing boxes versus poorly-performing boxes. 
 
When testing in a new box or material, there will not be any pre-defined standard available. Make 
sure the proper selector is un-checked. 
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Once a reference for a card board material or a box blank is available it is still necessary to setup 
the embosser before starting production. In this case check the Standard selector to compare 
actual readings with reference numbers. If the current readings are out of tolerance, the numbers 
will be displayed in red. 
 
 

 Clear statistics, start new statistics 
 
Measure the first sample 
 

 Add the first sample measurement to the statistics. All subsequent measurements are 
automatically added to the statistics until this Icon is clicked again. 
 

 Delete the most recent measurement from the statistics. 
 

 Click the OK Icon to create a PDF report of the current statistics. The report is automatically 
saved and may be printed. 
 

 Click the Save Icon to save all measurement data into a tab delimited text file. Important: in 
order to re-load the data to continue adding readings it is necessary to have checked the option 
‘Output Header’ in the settings window. Reload the data by clicking the ‘Load measurement data’ 
Item in the File menu. 
 

Bead measurements 
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The vertical axis (Y) of graphical display is zoomed by a factor displayed in the left top corner of 
the graph (Y:X = 3.4 : 1 in above example). This makes it easy to identify minor differences in 
shape and height of the Bead or Spine. 
 
The optimum bead is drawn as a gray background based on the reference values of the active 
reference. The current bead curve is displayed in black. The bead width is displayed at the top of 
the window (1.47, 1.51, 1.60). The bead height is displayed on top of the curve (0.16, 0.14, 0.15). 
Left and right angles are displayed at the left folding point and right folding point respectively.  
 
Symmetry is measured as the horizontal distance from the vertical centerline at the maximum 
height of the bead to the center of bead.  The numerical symmetry value in microns displayed in 
the table can be used to adjust the alignment of creasing rule and crease channel.  
 
The paper overhead produced by the creasing process is measured as Arc Length % and 
calculated as follows: 
 

 
 
The previous measurement displays as a red line. The average bead is displayed as a blue line. 

Crease measurement 
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Crease depth measurements are showing the deformation of the substrate. 
The crease width is measured at half depth (50%) as the crease cross section function is quite 
smooth at the substrate ends.  
Opening expresses the difference between the width at half depth and the width at substrate level. 
The interpretation of a narrow or wide opening can be made in the Settings menu. 
 

 
 
Crease depth = d 
Half crease depth = d*50% = d’ 
Crease width = W 
Crease opening narrow interpretation = o’-W 
Crease opening wide interpretation = O-W 
 
The Power Crease Module offers additional measurements. 
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Section = A+B 
Symmetry = B/(A+B) 
 

 
  
 

Manual measurement of bead and crease 

 
 

 

 

Move the mouse pointer to first position in your 
crease (or bead) 
 

 

 Press the left mouse button down and keep it 
depressed 
 

 

 

Move the mouse pointer to the second position 
in your crease (or bead) 
. 
 

 

 Click the right mouse button while the left 
mouse button is still depressed 
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Move the mouse pointer with left mouse button 
still depressed to the bottom of the crease (or 
to the top of the bead respectively) 
 

 

 

Release the left mouse button. The analysis is 
displayed in terms of crease depth (or bead 
height and bead width) 
 

 

Multi Crease measurements (Round Corner) 

 
 
Rounded corners are obtained by using multi crease technology. In this case several creases are 
produced with small distance between them. Select the number of creases in the settings Window. 
 

 
Select 1 to let the software automatically determine the number of available creases or beads and 
their distances. 
 
Position the CREASY well centered on the multi crease and press the measurement button. 
 

 
 
Bead height 
 
Single Bead distance 
 
 
 
 

 
The Statistics displays the average bead height and the average distance. 
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Beveled Edge measurement 
 

 
 
In order to create a beveled edge there are used two crease lines close to each other. The twin 
crease line can be measured with one single measurement as long as the distance of the two 
beads is less than 4mm. 
 
Center the twin bead line such as both beads are showing a similar distance to the extreme left 
and extreme right of the preview Window. 
 

 
 
Press the measurement key to capture and analyze an image and to calculate the beveled edge 
measurement values. 
 

 
 
Scroll the list down using the scroll bar to display additional measurement data. 
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The Software does calculate height, width, folding angles for both bead lines. In addition, a 
distance and a symmetry is calculated and displayed. 
 

Laser Crease Measurement 

 
 
Due to the special shape of laser crease line there is a special function available to measure depth 
and distance. Center the lines such as at the left and right side of the preview window are approx.. 
the same size of flat surface remaining. 
 

 
 
Press the measurement button of the device to execute a measurement. 
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Measure Scoring Depth 

 
Scoring or half cut cannot be measured flat as the card board is partially re-closing the cut line. 
Therefore, the sample is folded by 45° using the optional PowerBox holder. Insert the sample into 
the holder and fix it with the metallic cube. 
 
Folding needs to be done carefully such as the card board is not destroyed.  
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Now the scoring depth can be measured as the minimum of the straight portions of the two 
resulting shoulders (pink colored lines in below image) 
 

  
 
If folding is not done carefully, the card board could break slightly apart, making the flat portion 
between the two shoulders larger or making fibers visible in the middle of the scoring line. Further 
the two lines will be very different from each other. The quality of folding is measured in terms of 
symmetry (equal to the difference between the two line lengths). 
 
Bad folding leads to invalid measurement values! 
 

Cross Section measurement  
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Measure the bead, turn the sample over to the opposite side and measure the spine of the same 
crease. The software displays the overlaid image. 
 

  
 
 

Measure embossing or debossing on large areas 
 

 Select the embossing-debossing tool to measure embossing or debossing depth 
 

 
 
Manual measurement of height differences: 
 

 

 

Move the mouse pointer to the upper corner of 
the embossing area. A horizontal line is drawn 
when moving the mouse. 
 

 

 Press the left mouse button down and keep it 
depressed 
 

 

 

Move the mouse pointer to the second level of 
your embossing area. 
. 
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Release the left mouse button to obtain the 
measurement result 
 

 
Manual measurement of multiple height differences 
 
 

 
 

Move the mouse pointer to the upper corner 
of the embossing area. A horizontal line is 
drawn when moving the mouse. 
 

 

 Press the left mouse button down and keep 
it depressed 
 

 

 

Move the mouse pointer to the second level 
of your embossing area. 
. 
 

 
 

Confirm the second level with a click on the 
right mouse button while the left mouse 
button is still depressed. The height 
difference is calculated and displayed in the 
main window. 

 
 

Continue to insert levels with right mouse 
clicks until all height differences are 
calculated. 
. 
 

  

Release the left mouse button to obtain the 
average measurement result 
 

 
 
 

Fine structured Embossing or Debossing  
 
In many cases the embossing and debossing is composed only by small lines or characters, such 
as there can be several embossed or debossed areas inside the captured image of the device. 
 
Moreover the embossed or debossed areas are not necessarily uniform straight lines but they are 
composed of curves, lines are wider and smaller. This makes a simple edge height measurement 
impossible. 
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Version 1.5.0 of the software implements an additional tool to measure random height deviations 
due to embossing or debossing. 
 

 
 
Position the aperture over the embossed or debossed icon, text, or drawing. Make sure the 
embossed or debossed areas are quite visible inside the preview window. By slightly moving the 
device, maximize the visible difference between surface and embossed or debossed area. 
 

 
Press the measurement button on your device. The software will capture the image and 
automatically detect upper and lower areas. The software will automatically measure height 
deviations and calculate the maximum embossing or debossing. The maximum will be highlighted 
in red. 
 

 
 
The small numbers on top represent the height difference between the actual surface and the 
average surface height of the selected area (red line).  
 
The physical depth of above example is -0.071mm and is calculated as the level difference 
between its neighbor’s height and the own depth: 
 

−0.071𝑚𝑚 = −0.057 −  
0,017𝑚𝑚 + 0.011𝑚𝑚

2
  

 
This maximum embossing or debossing value is added to the table. 
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Measure on several locations and calculate the statistics: 
 

 
 
In case of embossing (negative numbers) the MIN value is the most appropriate to control your 
manufacturing process. 
In case of debossing (positive numbers) the MAX value is the most appropriate to control your 
manufacturing process. 
 
 
In general it is recommended to measure the inner side of the boxes to reduce the impact of print 
to the measurement results. 
 
CAUTION: The calculation of embossing and debossing differs from the calculation of bead 
height and crease depth.  
 
The bead and crease are assumed to have more or less round shapes. The height and 
depth therefore are calculated as the distance from the maximum peak to the surface of the 
material.  
 
The embossing and debossing are assumed to have a flat surface on top or bottom of the 
line. The embossing and debossing are calculated as the Average depth or height of the 
center area. 
 
As a result the embossing/debossing value is typically lower than the bead/crease value. 
 

Bead Crease Debossing Embossing  
 

Measure Embossing using E-GUIDE 

  
 
The E-GUIDE does support a 100% control of the embossed area.  
 
 

Setup the measurement position for embossing measurement with EGUIDE 

Position the box blank onto the table and fix it slightly with magnets. Take the CREASY device out 
of the holder and move the holder down. 
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Move the box blank below the holder until the embossing area is well centered. 
 

 
 
Move the holder to the starting point of the embossed area and fix the position with the screw 
 

 
Move the holder to the end point of the embossed area and fix the position with the screw. 
 

 
 
Fix the box blank position with the magnets to easily position the next box blank sample in exactly 
the same place. 
 
Insert the CREASY into the holder.  
 
Use the preview Window to check the correct positioning of the embossed area.  
 
At the starting position and the end position the Window should show a flat line without any 
embossed area 
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  OK    not OK 
 
 
In case there is not enough flat carton surface on top and bottom of the embossing feature, there 
can be selected a more narrow  aperture size from the drop down list: 
 

  
 
Now move the carriage with CREASY mounted manually over the embossed are and check if the 
embossed area is well positioned. The carriage can be moved manually by pressing the UNLOCK 
button 
 

 
 

In case the logo is smaller than the aperture or you measure a special embossing test 

patch , while moving the embossed area needs to stay inside the blue frame. The 
area at the left and the area at the right are taken as surface reference and should be flat all over 
the scanning area.  
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In case the surface reference is taken only at the beginning and at the end of the scan, 
there is no need that the left and right areas are flat all over the scanning distance. In any case, for 
easy finding the same position again it helps to position the embossed area such as the 
embossing matches the left side of the blue frame. 
 

 
 

Define the Measurement Aperture 

The measurement aperture of the CREASY device can be limited by selecting the proper item from the Scanning 
aperture size list. 
 

  
 
  

 

Measure Embossing with E-GUIDE 
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• Position the box blank 
 

• Move the device to the start position. 
 

• Press the measurement button to start the measurement process. Release the button. 
 

• Wait until the traffic light turns green. 
 

• E-GUIDE: Move the device over the box blank according to the bar on the screen. 
 

• EGUIDE-PRO: The CREASY is moved automatically over the embossed area capturing 
images. The Scroll bar will display also the actual settings i.e. 
 

o Ad-hoc measurement or REF in use 
o Hills or valleys 
o Where the surface reference for depth calculation will be taken from 
o Scanning distance (approximative) 

 

 
 

o In case of an error the scanning can be interrupted by clicking the left top black circle 
with the mouse. After scanning has been finished (i.e. the CREASY is moving back 
to home) no interrupt is any more possible. 
 

• EGUIDE-PRO2: The CREASY is moved to the home position or to the starting position of 
the embossed feature if defined. The CREASY is moved with a constant speed over the 
embossed feature such as the sampling rate for cross images is 0.05mm for short 
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distances < 25mm, 0.1mm for medium distances between 25mm and 50mm and 
Distance/500mm for long distances between 50mm and 100mm.  

 

• The software automatically;  
o creates a 3D image  based on 200 cross sections with 1280 measurements each 
o calculates the Embossing value as the average of the 10% highest (deepest)  areas 

 
IMPORTANT: Don’t press down the CREASY while pulling. Pull it without pressure to make 
sure you do not flatten the embossing area. 
 

100% Embossing control – what does this mean 

 

 
 

Click inside the gray scale image to visualize a cross section. Click the  left right Icon to 
move from one cross section to the next. 
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The red area displays the 10% max plain level. The green line displays the reference or the 20 
micron level if no reference is selected. 
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Move the mouse to the starting point, press the left mouse button and keep it depressed while 
dragging the mouse to the right. Release the left mouse button to display the cross section in the 
opposite direction. 
 

 By the same way you can select the area that should be used to re-calculate the 
measurement result. Click the calculate Icon to recalculate the result excluding areas outside the 
cross section area. Please note: a minimum of 100 real cross section images is required for the 
calculation. If less images are selected, the entire image is used for recalculation. 
 

 
 

Measure embossing patches 

The measurement of embossing test patches does not require the specification of scanning 
parameters at all.  
 

 
 
All parameters are selected Automatically. The Software will automatically detect the two 
embossing areas and calculate depth or height. 
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Tactile warning triangle  

 
The tactile warning triangle is larger than the aperture of the creasy scanning area. The triangle is 
positioned such as the base line and a section of the left and right triangle shoulders are inside the 
aperture. 

 
The preview window in the left bottom corner displays blue lines such as you can align the sample 
properly. 
 

 
 
Click the button on the Creasy or the Capture button of the software to start the scanning process. 
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The software will automatically scan over the area and capture the 3D image. There will be 
measured 3 cross sections A, B, and C as displayed in the main Window. 
 
 

View 3D 
The option View 3D can be accessed by clicking the 3D Icon of the main menu bar after a valid 
embossing measurement 
 

 
 
There will open a Window displaying the 3D image of the most recent scan 
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Use the adjust functions to adjust viewing angle, viewing distance and depth zoom. 
 

  Change the size of the 3D object 
 

 Move the object to the left, right top or bottom 
 

  Rotate the object back and forward 
 

 Rotate the object to the side 
 

  Zoom in depth to see more details 
 
Click the proper symbol to reset the settings to default. 
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The 3D image can be displayed in gray scales or in color, whereby the color tells about the depth 
from the absolute top location. 
 

 
 
The current image can be saved as JPG or PNG or BMP file to use it in reports and presentations. 
 
Select the size of the output file from the list 
 

 
 
Click the save icon, insert a file name, select file format and click OK. 
 

 
 
Close the window by clicking the OK Icon 
 

 
 
 
 

 

Finished box control 
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Attach the angle tool accessory to the CREASY device in order to have a 45° reference. Hold the 
finished box with one side parallel to the 45° plane of the Angle accessory 
 

   
 
Check the preview window and make sure the spine is visible inside the window. Please note that 
for higher measurement accuracy the vertical resolution of the image is higher than the horizontal 
resolution. Therefore a 90° opening angle will look like approximately 60°.  
 
Press the button of the CREASY to capture an image and to analyze the edge properties. 
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Bead width = length of line D 
Symmetry = line C:D intersection point position compared to the center point of line D 
Folding angle = real world angle between line A and B corrected for all projections 
 

Measure the finished Box with Power Box 
 
Power box offers additional measurement values 
 

• Radius 

• Roundness 
 

 
The Radius can be pre-defined by inserting the value into the proper field. 
 

 
 
If no value is inserted, then the radius will be calculated automatically as the radius of the circle 
that fits best between the two sides. Whenever a reference definition is selected the radius will be 
taken from the reference. 
 
The roundness is the area difference between the perfect circle and the actual shape of the box 
(see green histogram in above example). 
 

Measure the cutting-edge quality 
Sharp cutting knifes will lead to clean cutting edges. Non-clean cutting edges will have an impact 
on paper dust in subsequent production processes like printing. Therefore, the cutting edge should 
be as clean as possible. 
 
Select the cutting tool from the tool panel. 
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There are two approches to look at the edge. From top (left picture) and from front (right picture). 
It is important that you use always the same approach to obtain repeatable and comparable 
measurement results. 
 
Mount the paper holding block on the bottom side of the CREASY. Move it to the front and back 
until the cutting edge is displayed sharply. 
 

 
 
Fix the block using the screw on the side. 
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Click the measurement button on the device or execute a measurement using the capture Icon of 
the Software. 
 

 
 
The Software will calculate three measurement values: 
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D is the base line. 
 
The base line can be selected as the linear regression line through the measurement points or as 
the real paper edge including occasional warp. Select the base line type to be used in the settings. 
 

 
 
If wave compensation is selected the real edge is used as base line and the label of the 
measurement values will show (w). 
 
 
 
 

Daily production quality control of creasing 
 

 Start the measurement of a new box blank in production quality control by clicking the new 
job icon. 
 
Enter the Job Identification number, select the standard you want to work with, and enter the name 
of the operator. 
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 Click the OK Icon to continue 

 Click the CANCEL Icon to abort  
 
The Bead measurement function is selected automatically and the Job table appears in the Result 
Window. 
 
If you would like to measure the crease, select Card board Crease (Power Crease only) 
 
If you would like to measure the Creasing channel select Creasing Channel (BOBST version only) 
 
Select A type measurements by clicking on the A on top of the table. 
 

 
 
The Basic version of the creasy software always shows just the standard box layout. 
 
The PREMIUM Version of the software now displays the Box Layout that has been assigned to the 
active reference containing all [A] measurement locations. Measurements of type [B],[C], and [D] 
are hidden. 
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Measure as many type [A] locations as required. The Average and Standard Deviation are 
calculated automatically. 
 
Select [B] type measurements by clicking on the [B] on top of the table. 
 

 
 
The PREMIUM version now displays the [B] locations. 
 

 
 
Measure as many type [B] locations as required. Average and Standard Deviation are calculated 
automatically 
 
 
Continue by selecting [C] and [D] and measuring the proper creases. The PREMIUM version 
supports seven crease types. Use the scroll bar on bottom to scroll additional crease types into 
view. 
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Out-of-tolerance values are highlighted in red. 
 

 Click this Icon to restart the measurement of the current Box 

 Click the Delete Icon to remove the most recent measurement 

 Click the OK Icon to create a report 

 Click the Cancel Icon to exit without creating a report 
 

 Click the Save Icon to save all measurement data into a tab delimited text file. 
 
The measurement procedures for crease and crease channel are basically the same as for the 
bead measurement. Select the crease option or the crease channel option in the starting window. 
The tables will than contain measurement data for crease or crease channel measurements in 
place of measurement data for bead measurements. Only the measurement values obtained are 
as required. 
 

Daily production quality control of embossing (Power Crease) 
 

  
 
Start the measurement of a new box blank in production quality control mode by clicking the New 
Job Icon. Enter the Job Identification number, select the standard you want to work with, and enter 
the name of the operator. 
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Proceed the same way you did for crease and bead measurements. Select the measurement 
position A..F and take readings. In case of Embossing or De-Bossing the maximum is collected. 
 

 
 
If E-GUIDE is activated and the reference selected is an E-GUIDE embossing reference, then the 
E-GUIDE measurement data is collected in the table. 
 

 
 
 

 Click this Icon to restart the measurement of the current Box 

 Click this Icon to delete the most recent measurement 

 Click the OK Icon to create a report 

 Click the Cancel Icon to exit without creating a report 
 

 Click the Save Icon to save all measurement data into a tab delimited text file 
 

Dayily production quality control using the embossing patch (Power 
Crease) 
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Start the measurement of a new box blank in production quality control mode by clicking the New 
Job Icon. Enter the Job Identification number, select the standard you want to work with, and enter 
the name of the operator. 
 

 
 
Position the test patch and take a reading. The software automatically inserts the data into the 
database such as the deeper area value is inserted in column A and the flat area value is inserted 
in column B. The software will display a green flag if the readings are in tolerance and a red flag in 
case they are out of tolerance. 
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Daily production quality control of finished boxes (Power Crease + 
Power Box required) 
 

 
 
Start the measurement of a new box blank in production quality control by clicking the New Job 
Icon. Enter the Job Identification number, select the standard you want to work with, and enter the 
name of the operator. 
 
 

 
 
Measure the corners as requested by the software: 
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 Click this Icon to restart the measurement of the actual Box 

 Click this Icon to delete the most recent measurement 

 Click the OK Icon to create a report 

 Click the Cancel Icon to exit without creating a report 
 

 Click the Save Icon to save all measurement data into a tab delimited text file 
 

Daily production quality control of cutting (Power Crease + Cutting 
required) 
 

 
 
Start the measurement of a series of sheets in production quality control by clicking the New Job 
Icon. Enter the Job Identification number, select the standard you want to work with, and enter the 
name of the operator. Insert the number of sheets (Patch Size) and the number of measurements 
to take per edge. 
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Start to measure the cutting edges. The software will show the current edge to measure 
graphically. 
 

 
 
Once all positions of a sheet have been measured click the next sheet icon to start with the next 
sheet. 
 

 
 
 

 Click this Icon to restart the measurement of the series of sheets 
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 Click this Icon to delete the most recent measurement of the current sheet 

 Click the OK Icon to create a report 

 Click the Cancel Icon to exit without creating a report 
 

 Click the Save Icon to save all measurement data into a tab delimited text file 
 

Statistics 

 Open Statistics on quality reports 
 
Select the sample type (Card board Bead, Card board Crease, Embossing/Debossing) 
 
Select the Standard from the list of available Standards 
 
Select the time frame by selecting the FROM date and the TO date appropriately 
 
Select the Job Identification number. You can select a specific job identification number to 
calculate a statistics over all measurements of this job. You can also use wild cards like ‘*’ to 
select similar job numbers. 
 

 
 

Click the Statistics Icon to calculate the statistics. All selected jobs will be listed. The overall 
Average, the Standard Deviation, the maximum and the minimum are calculated and displayed in 
a table. The measurement results of the selected quality reports will be displayed graphically. 
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Embossing Test Patch statistics 

Select Embossing Patch, select Standard, Time Frame, and ID number and click the Statistics 
Icon to calculate the statistics on Embossing Patch readings. 
 

 
 
This function calculates and displays compliance values: 
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 Export the measurement data to a text file or to an excel file. 

Select and display a report 

Move the mouse pointer on one of the squares on one of the curves. 
 

 
 
Click the left mouse button. 
The associated report will be displayed automatically and can be printed. 
 

Create a job summary report 

 Click the Job Summary Icon to create a summary report of the selected job 
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CREASING RULE measurement 
 
If the CREASING RULE option is activated there can be selected the CREASING RULE function 
by clicking the selector. 
 

 
 
This will make available two additional measurement functions, optimized to measure steel 
creasing rules. 
 

Select this function to measure high steel creasing rules for example on web creasing 
tools. 
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 Use this function to measure lower creasing rules. 

 
 
In case of parallel creasing rules for round corner applications all single rules are measured. The 
measurement data is displayed on top of the rule in the main Window. The value on top is the 
height of the rule. The value between brackets <> is the width of the rule measured at 95% of its 
height. If there are more than 2 rules in parallel, the rule dimensions in the middle highlighted with 
green values are averaged and the average number is added to the measurement table. In case 
of two parallel rules, the average of the two is taken. In case of a single rule, the measurement 
values of the single rule are copied to the table. 
 

 
 
 
Both functions have to be activated in the settings. 
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Device verification 
The CREASY comes with the CREASY target reference plaque that can be used for internal 
Device verification. 
 
Open the Verification Tool by selecting the Verify Menu Item from the Device menu. 
 
Type the reference numbers written on the reference plaque into the proper edit fields for bead 
and crease verification 
 
Position the device on the Bead side of the plaque and press the measurement button. Now rotate 
the plaque and measure the crease. If both measurements are in tolerance, you can create a PDF 
report and print the report using the PDF functions on bottom. 
 

 
 

High resolution verification (PREMIUM Version only) 

The CREASY STEP WEDGE can be acquired as an option to perform high resolution verification 
of the CREASY device. Based on a Look-Up table this feature can be used to match one CREASY 
device perfectly to another over very long time periods. 
  
Open the high resolution function by selecting the ‘Verify Scale’ Item from the main menu ‘Device’. 
 

 Insert the reference values from the CREASY STEP WEDGE label into the reference 
column of the table. Make sure to insert the lowest value on top. Click the SAVE Icon to save the 
reference values. 
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 Click the CLEAR Icon to clear the table. Now start measuring each level starting with the 
lowest level. The absolute height will be displayed in blue color and the difference in red color in 
real time inside the graph. 
 

 In case the differences are out of tolerance you can calculate a LUT (Look-Up Table) by 
clicking the LUT Icon. The LUT will be automatically stored and applied on all future 
measurements until a new LUT is created. The LUT improves the Inter-instrument Agreement of 
the devices. 
 

 Finally click the report Icon to create a calibration report. 

  
 

EGUIDE-PRO Embossing measurement verification 

The EGUIDE-PRO TARGET can be acquired as an option to the EGUIDE-PRO device. The 
EGUIDE-PRO TARGET is used to check the inter instrument agreement in terms of embossing 
between devices in the field. The EGUIDE-PRO TARGET offers two engraved EGUIDE text fields 
that are going to be measured one after the other and a report is created. There is also a 
password protected function to adjust the device to the numbers printed on a label on the 
EGUIDE-PRO Target. 
 
Before executing an EGUIDE-PRO Embossing verification there should be executed the EGUIDE-
PRO Distance Calibration. 
 
Make sure the EGUIDE-PRO Target is clean. Place the Target as displayed on below Window. 
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Select the Verify EGUIDE-PRO Item from the Device menu. 
 

 
 
Insert the reference numbers displayed on the EGUIDE-PRO Target. Move the Device to the 
starting positon of the first engraved area. 
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 Start Scanning by clicking the capture icon next to the reference on top. The Device will 
now move 40mm. Make sure that in any case it will move to a position between the right 
end of the horizontal line and the starting point of the second engraved area. 

 Now move the device manually to the starting point of the second engraved area. Click the 
capture Icon again and wait until the measurement is finished. In case your device is in 
tolerance you can create a report. 

 
If your device shows red-flag Icons, repeat the verification and make sure the positioning is 
correct. If you still do not get green-flag results, you can perform an adjustment of the device. 
 
Click the ‘…’ Symbol below the Scan Images. You will get prompt for a password. 

 
 
This now makes available two new functions. 
 

 
 
Click the RESET Icon to reset your device to Factory default. 
Perform a verify test as described above. Don’t care about red-or green flags. 
Click the TARGET icon to perform the adjustment. 
Perform a verify test as described above. Now you should see only green-flags any more. 
Create a PDF report. 
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